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Объект исследования – процесс обучения информатике в основной 

школе. 

Цель исследования – разработать комплекс объектов дополненной 

реальности для использования в процессе обучения школьников 

информатике. 

В работе проанализированы основные понятия, методы и средства 

технологий дополненной реальности, практический опыт применения в 

образовании, в том числе – для обучения обучающихся основной школы. 

Разработано приложение для смартфонов на платформе Android для 

использования объектов дополненной реальности. Его можно применять в 

процессе обучения информатике как на уроках, так и при подготовке к 

занятиям дома. При желании преподаватель может дополнить разработанное 

приложение своими объектами, а также адаптировать его под устройства на 

iOS.  

Разработан комплекс элементов дополненной реальности по 

информатике – созданы элементы дополненной реальности с помощью 

плагина Vuforia на игровом движке Unity и метки для них. Проведена 

апробация продуктов разработки и анализ полученных результатов. 

Созданные AR-элементы могут быть использованы на уроках информатики, 

а также могут служить основой для разработки подобных элементов для 

других школьных дисциплин. 
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Введение 

В современную эпоху информационных технологий одними из главных 

компетенций успешного человека являются умения работать с информацией. 

Информационные технологии стремительно и уверенно проникают во все 

сферы нашей жизни, не стало исключением и образование.  

В настоящее время происходит дальнейшее развитие информационного 

общества, в котором доминирующим видом деятельности является 

производство информационного продукта. Интеграция в это общество 

зависит от эффективности работы человека с информацией. Кроме того, 

потоки информации, в которых необходимо ориентироваться современным 

специалистам, возрастают, стимулируя тем самым разработку новых 

технологий для работы с информацией, то есть информационных 

технологий. 

Информатизация образования – неотъемлемая часть формирования 

информационного общества. Информационные технологии используются на 

уроках разных типов: для объяснения нового материала, организации 

самостоятельной работы, для контроля и оценки успеваемости обучающихся. 

От овладения обучающимися способами деятельности с помощью таких 

технологий зависит не только эффективность обучения, но и готовность к 

жизни в современном обществе. 

От 31 мая 2021 года утвержден Федеральный государственный 

образовательный стандарт основного общего образования (ФГОС ООО), в 

основе которого лежит системно-деятельностный подход как обеспечение 

освоения обучающимся компетенций, необходимых для жизни в 

современном обществе [16]. Реализация ФГОС обеспечивает разумное и 

безопасное использование цифровых технологий, обеспечивающих в свою 

очередь повышение качества результатов образования. В стандарте 

выделены метапредметные результаты освоения образовательной программы 
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такие, как формирование и развитие компетенций обучающихся в области 

использования ИКТ, формирование культуры пользования ИКТ. 

Недостаточное количество наглядного материала, специального 

оборудования, химических реактивов и оборудованных классов для 

проведения лабораторных работ влечет за собой сложность в построении 

обучающимися взаимосвязи теории с практикой, что приводит к снижению 

мотивации обучающихся. 

Можно сказать, что ситуация в сфере образования, связанная с 

проведением практических занятий и повышением наглядности 

образовательного процесса, обуславливает актуальность использования 

современных информационных технологий на уроках. Одним из 

перспективных направлений развития таких технологий является 

применение дополненной реальности (Augmented Reality, AR-технология) 

для обучения школьников. 

Специфика технологий дополненной реальности заключается в 

совмещении мира реальных объектов и виртуального мира, созданного на 

компьютере. Новая виртуальная среда образуется путем наложения 

виртуальных объектов поверх реальных объектов, окружающих нас, в 

реальном времени, и становится интерактивной путем использования 

специальных маркеров. 

Использование AR в процессе обучения предоставляет обучающимся 

возможность безопасно провести химические эксперименты, рассмотреть 

объемные фигуры, представленные в учебнике, с разных сторон, что касается 

информатики – увидеть работу отдельных частей компьютера, представить 

алгоритм кодирования информации и т.п. Виртуальные образы, которые 

обучающиеся могут увидеть прямо в учебном классе, делают учебный 

материал более наглядным и запоминающимся. Повышается интерес к 

изучаемой дисциплине, поскольку AR-технологии не требуют 

дорогостоящего оборудования, для их использования достаточно иметь при 
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себе гаджет (смартфон). Создание AR-объектов не требует наличия навыков 

в программировании.  

Таким образом, актуальность использования объектов дополненной 

реальности в обучении заключается в повышении наглядности учебного 

материала по информатике и интереса обучающихся к изучению 

дисциплины, а также формировании ИКТ-компетенций на уроках 

информатики. 

Объект исследования: процесс обучения информатике в основной 

школе. 

Предмет исследования: использование технологии дополненной 

реальности в обучении школьников информатике. 

Цель исследования: разработать комплекс объектов дополненной 

реальности для обучения школьников информатике. 

Для достижения цели были сформулированы следующие задачи 

исследования: 

1. Провести анализ литературы и сетевых ресурсов, посвященных 

технологиям дополненной реальности и их использования для обучения, а 

также программно-аппаратных средств создания объектов дополненной 

реальности. 

2. Провести анализ содержания обучения информатике в средней 

школе и выбрать темы, позволяющие дополнить учебный материал 

мультимедийными объектами для облегчения его восприятия и понимания. 

3. Разработать комплекс объектов и приложение дополненной 

реальности для использования на уроках информатики в школе. 

4. Разработать краткие методические рекомендации по созданию 

учебных AR-объектов и приложения для работы с ними, провести апробацию 

созданных ресурсов.  
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1 Теоретико-технологические основы разработки элементов 

дополненной реальности для обучения 

1.1 Технологии дополненной реальности: сущность, методы и средства 

разработки 

Сущность технологии дополненной реальности 

Дополненная реальность (англ. Augmented Reality, AR) – одна из 

многих технологий взаимодействия человека и компьютера. Специфика 

технологии заключается в том, что она программным образом визуально 

совмещает два изначально независимых пространства: мир реальных 

объектов вокруг нас и виртуальный мир, воссозданный на компьютере. 

Новая виртуальная среда образуется путем «наложения» (отображения 

на экранах электронных устройств) запрограммированных виртуальных 

объектов (сгенерированных компьютером графиков, текстов, аудио- / 

видеообъектов, 2D / 3D-моделей и др.) поверх реальных объектов 

окружающего мира, и становится интерактивной путем использования 

специальных маркеров [9, 11]. 

Термин «дополненная реальность» был предложен в 1990 году 

исследователем корпорации Boeing Т. Коделом [30]. Он употреблял этот 

термин, описывая цифровые дисплеи, которые использовались при 

постройке самолетов. Сборщики носили портативные компьютеры, могли 

видеть чертежи и инструкции с помощью шлемов, имеющих полупрозрачные 

дисплейные панели [8]. 

Впервые устройства типа Augmented Reality появились еще в 70-х 

годах XX века. Профессор Гарвардского университета доказал, что можно 

соединить две реальности в одну, при этом, чтобы они не мешали друг другу 

(рис. 1) [25]. После этого дополненная реальность использовалась военными 

и сотрудниками авиации для тренировок. Айвен Сазерленд смог дополнить 

вид комнаты, которую видели пользователи, геометрической сеткой.  
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Развитие технологий создания реальностей (виртуальной и 

дополненной) дало несколько форм смешанной реальности (Mixed Reality, 

MR). Одним из видов MR является возможность накладывать объекты на 

реальный мир и взаимодействовать с ними. Такую форму смешанной 

реальности можно считать передовой формой AR. Необходимо отличать 

дополненную реальность от виртуальной реальности. Под термином 

«виртуальная реальность» (Virtual Reality, VR) понимается среда, полностью 

созданная компьютером. Человек погружается в нее с помощью VR-шлемов 

и не видит объекты реального мира [1, 14]. 

 

Рисунок 1. Прототип первого видеошлема 

Первые AR-разработки относились больше к научным экспериментам, 

но с развитием технологии открывались новые прикладные области. 

Первыми сферами были обучение и технологический процесс. В настоящее 

время уровень развития компьютерных наук и электроники открывает 

огромный простор для применения дополненной реальности. Технология 

используется учеными, врачами, артистами, производителями игр, 

маркетологами и т.д. [18, 23, 24] Например, известные бренды, такие как 

Nestlé и Jaguar Land Rover, экспериментировали с использованием AR для 

предоставления персональных консультаций, информации о происхождении 

товаров или дополнительных услуг для их продуктов. IKEA интегрировала 

AR в свое приложение, с помощью которого можно проверить, как мебель 

будет выглядеть в доме.  
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К 2020 году AR-технологии стали дешевле и доступнее для 

потребителей. Технологии, например ARKit от Apple, позволяют 

интегрировать элементы дополненной реальности в изображение с камеры 

смартфона или другой электроники. Постепенно происходит подготовка к 

использованию новых устройств таких, как HoloLens или Google Glass, но с 

более продвинутым аппаратным и программным обеспечением. 

Естественно, развитие компьютерных технологий оказывает влияние и 

на технологии обучения. Позволяет пополнить их средства и методы, 

расширяет возможности образовательного процесса. С помощью размещения 

виртуальных объектов в среде, в которой они изначально отсутствуют, 

можно реализовать новые образовательные практики. 

Однако в связи с ограничениями, которые возникают из-за 

особенностей взаимодействия человека с компьютером посредством экрана, 

обеспечивающего представление интерфейса для вывода информации, AR-

технологии до сих пор являются непривычным инструментом представления 

учебно-методического обеспечения дисциплин. 

Повышение уровня компьютерной грамотности, распространение 

информационных технологий на сферы деятельности человека, быстрое 

развитие мобильных устройств и игровой индустрии – источники 

популяризации технологии дополненной реальности. AR появилась на рынке 

в начале 2000-х, но по-настоящему раскрылась в 2016 году благодаря игре 

Pokémon Go: игрок использует камеру и систему геолокации, чтобы искать и 

ловить покемонов на улицах, в парках и т.д. Наложение 3D-объектов и 

специальных меток на окружающую местность стремительно заинтересовало 

пользователей, вызвало резонанс в теле- и социальных сетях [33]. 

Методы разработки приложений дополненной реальности 

Дополненная реальность позволяет человеку ощущать реальный мир 

вместе виртуальными объектами, наложенными на окружающую обстановку. 
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Таким образом, AR интегрируется и дополняет настоящий мир вместо того, 

чтобы полностью его заменить, как это делает виртуальная реальность. 

Основой технологии дополненной реальности является система 

оптического трекинга: «глазами» системы становится камера, а «руками» – 

маркеры. Под маркером понимается объект, расположенный в окружающем 

пространстве, который находится и анализируется специальным 

программным обеспечением (ПО) для последующей отрисовки виртуальных 

объектов [3]. Камера распознает маркеры в реальном мире и переносит их в 

виртуальную среду, накладывает один (виртуальный) слой реальности на 

другой (реальный). Таким образом, создается мир дополненной реальности.  

Существуют три основных метода разработки (и направлений 

развития) AR-технологии: 

1) «Безмаркерная» технология AR. «Безмаркерная» технология – 

это новое, динамично развивающееся направление дополненной реальности 

(рис. 2). В ее основе лежат особые алгоритмы распознавания, где на 

окружающую среду, снятую камерой, накладывается виртуальная «сетка» 

[41]. На этой сетке программные алгоритмы находят некие опорные точки, 

по которым определяют точное место, к которому будет «привязана» 

виртуальная модель. 

Преимуществом такой технологии является то, что объекты реального 

мира сами по себе являются маркерами и не нужно создавать специальных 

меток. Торговая марка и логотип, пейзаж, портрет, фотография или 

репродукция картины – любое изображение может быть использовано для 

программирования трехмерной модели. Главное требование – контрастность 

картинки, наличие достаточного количества опорных точек, чтобы камера 

могла корректно распознавать их среди других меток. 
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Рисунок 2. Примеры «безмаркерной» технологии AR 

2) AR-технология на основе маркеров или меток. Технология на 

базе специальных маркеров или меток удобна тем, что они проще 

распознаются камерой и дают ей более жесткую привязку к месту для 

виртуальной модели (рис. 3). Такая технология гораздо надежнее 

«безмаркерной» и работает практически без сбоев. 

Привязка к маркеру – механика, при которой объект в дополненной 

реальности появляется при наведении камеры на физический оригинал. 

Контент дополненной реальности запускается, когда в поле зрения камеры 

появляется определённый триггер. Маркер – это своего рода QR-код, 

который также является частью технологий дополненной реальности. Он 

инициирует цифровые анимации для просмотра пользователями, вследствие 

чего изображения могут превращаться в 3D-модели. Маркерная технология 

(самая простая и популярная) обобщенно может быть описана следующими 

процессами: захват камерой объекта реального мира и передача видеопотока 

в компьютер; анализ программным обеспечением компьютера кадров 

видеоизображений и поиск наличия специальных меток (маркеров, 

триггеров); вычисление позиции камеры относительно маркеров; отрисовка 

виртуального объекта в видеокадре; отображение на месте маркера 

виртуального объекта [5, 7, 11]. 
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Рисунок 3. Примеры меток для AR-технологии на базе маркеров 

3) «Пространственная» технология. Кроме маркерной и 

безмаркерной, существует технология дополненной реальности, основанная 

на пространственном расположении объекта (рис. 4). В ней используются 

данные GPS/ГЛОНАСС, гироскопа и компаса, встроенного в мобильный 

телефон. Место виртуального объекта определяется координатами в 

пространстве – когда они совпадают с фактическим расположением 

пользователя, программа активируется [13]. 

 

Рисунок 4. Пример «пространственной» технологии дополненной реальности 

Чтобы исключить технологические риски и преодолеть проблемные 

моменты, при разработке элементов дополненной реальности мы остановили 

выбор на надежной маркерной технологии дополненной реальности. 

Кроме того, использование маркерной технологии позволяет: 
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 печатать метки в учебниках, которые можно использовать в 

общеобразовательных учреждениях при изучении конкретной темы и 

проведении практических работ; 

 активизировать пространственное мышление обучающихся (поскольку 

обучающиеся следят за положением маркера по отношению к камере и 

манипуляциями с маркером / камерой) [10].  

Средства разработки AR-приложений 

Чтобы создать собственное приложение дополненной реальности, 

понадобится набор средств разработки (SDK). Ниже рассмотрели наиболее 

популярные SDK [27, 28, 29, 32, 34, 38, 42]. 

Vuforia. Доступный SDK для пользователей Unity, легко интегрируется 

и поддерживает кроссплатформенное развертывание, предлагает широкий 

набор функций. 

Бесплатная версия SDK используется для создания обнаружения на 

основе маркеров и облака, а также обеспечивает создание приложений для 

небольших задач. 

Функционал бесплатной версии Vuforia: 

 распознавание 2D и 3D объектов (например, цилиндры, коробки и 

потребительские товары); 

 распознавание текста (имеется стандартный английский словарный 

запас, содержащий более 100 000 слов); 

 проигрывание видео (воспроизведение видео при обнаружении 

целевых поверхностей); 

 VuMarks – штрих-коды Vuforia, которые кодируют данные и действуют 

как маркеры; 

 локальное или облачное распознавание. 

Данный набор средств разработки доступен в бесплатной и платной 

версии. В бесплатной версии ограниченный функционал и водяные знаки 
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Vuforia. Дополнительные функции, которые раскрывают весь потенциал 

доступны по нескольким коммерческим лицензиям. 

EasyAR. Набор средств разработки, который предлагает передовые 

функции, например SLAM, 2D-3D-отслеживание, запись экрана. Даже в 

бесплатной версии SDK имеются следующие функции: облачное 

распознавание и неограниченное количество запросов на распознавание, 

хранение до 1000 меток на устройстве. Предусмотрена бесплатная и платная 

лицензии. 

MaxST. Предлагает два типа программного обеспечения для создания 

AR-приложений: Maxst AR SDK 2D и Maxst AR SDK 3D. Один инструмент 

позволяет распознавать только 2D-изображения, а другой – 3D-изображения. 

Также MaxST поддерживает технологию пространственной дополненной 

реальности с VPS-технологией, определяющую местоположение и 

предоставляющую услуги дополненной реальности для помещений и на 

открытом воздухе. 

MaxST – инструмент разработки на основе Unity, поддерживающий 

такие операционные системы, как Android и iOS. 

Функционал SDK: 

 Maxst AR SDK 3D имеет такие функции, как SLAM, эффект 

физического движка и эффект окклюзии; 

 Maxst AR SDK 2D имеет функции распознавания нескольких 

изображений (до 200 изображений на канал), увеличением видео и др. 

 Мгновенное отслеживание объектов, изображений и отслеживание 

маркеров, сканер QR/штрих-кода. 

Инструменты доступны по бесплатной лицензии (с водяными знаками), 

а также по коммерческой лицензии. 

Apple ARKit. Датчики камеры точно отслеживают окружающую среду, 

группируя визуальную информацию с расширенным анализом 

компьютерного зрения. Привязка местоположения использует данные в 
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Apple Maps, чтобы разместить возможности AR в определенной точке мира в 

приложениях для iPhone и iPad. 

ARKit доступен только на «свежих» устройствах iOS и недоступен на 

устройствах Android, распознавание объектов низкого качества.  

Функционал Apple AR SDK: 

 обнаружение плоскости позволяет сканировать окружающую среду и 

находить горизонтальные плоскости (полы, столы и т.п.); 

 оценка освещения анализирует количество света и регулирует 

количество света, падающего на виртуальные объекты; 

 вычисление глубины резкости камеры и наложение соответствующего 

эффекта размытия; 

 ARKit можно использовать в сочетании с движками Unity и Unreal; 

 отслеживание лиц на устройствах с Apple Neural Engine и фронтальной 

камерой. 

Google ARCore. Предоставляет собственные API-интерфейсы для 

основных функций дополненной реальности: отслеживание движения, 

понимание окружающей среды и оценка освещенности. Некоторые из 

особенностей SDK включают в себя: 

 Обнаружение плоских и наклонных поверхностей, оценка среднего 

освещения вокруг них. 

 Автоматическая регулировка освещенности. ARCore автоматически 

скорректирует изображение при тусклом освещении. 

 Привязка виртуальных объектов к физическим объектам. Если выйти 

из комнаты и вернуться, виртуальный объект останется на прежнем 

месте. 

 Определение размера и местоположения вертикальных, 

горизонтальных и наклонных поверхностей. 

 Интеграция с Unity и Unreal Engine. 
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AR.js. AR SDK с открытым исходным кодом на основе Java Script для 

создания приложений в браузере. Используется для создания сцен на основе 

маркеров. Для создания AR-решения на основе AR.js необходимо создать 

HTML-файл и подключить в него соответствующие библиотеки. Маркеры 

стабильны, но накладываются ограничения на форму, цвет и размер. 

8thWall. Набор средств разработки на базе Интернета. Работает как с 

плоскими, так и с изогнутыми поверхностями (например, бутылки, чашки, 

банки), обеспечивает потоковую передачу объемного видео в WebAR 

(голограммы). 

Основные функции: 

 поддержка маркеров (Image Target), World Effects, Face Effects, SLAM; 

 функция записи видео в браузере; 

 стадии развертывания, включая промежуточную среду, защищенную 

паролем; 

 оценка освещенности и относительный масштаб; 

 интеграция с Unity и Unreal; 

 платная лицензия. 

Основываясь на приведенных выше характеристиках различных 

средств разработки AR-приложений, составили сравнительную таблицу 

ведущих платформ дополненной реальности (табл. 1): 

Таблица 1. Сравнительная характеристика ведущих платформ дополненной реальности 

SDK Vuforia EasyAR MaxST Apple 

ARKit 

Google 

ARCore 

AR.js 8th Wall 

Лицензия беспл., 

коммерч

. от 

42$/мес. 

беспл., 

коммерч

. от 

39$/мес. 

беспл., 

коммерч

. от 

49,9$/ме

с. 

беспл. беспл. беспл. без 

коммерч. 

от 

99$/мес., 

коммерч. 

от 

1250$/ме

с. 

Поддерживаем

ые платформы 

Android, 

iOS, 

Window

Android, 

iOS, 

Window

Android, 

iOS, 

Window

iOS Android, 

iOS, 

Window

Android, 

iOS, 

Window

Android, 

iOS, 

Windows, 
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s, UWP s, 

macOS, 

UWP 

s, 

macOS 

s, 

macOS 

s, 

macOS 

macOS 

Поддержка 

Unity 
+ + + + + + + 

Поддержка 

умных очков 
+ – + + + + – 

Распознавание 

облака 
+ + – + + – + 

3D 

отслеживание 
+ + + + + – – 

Геолокация + – + + + + – 

SLAM + + + + + – + 

После сравнительного анализа программного обеспечения для создания 

приложений и объектов дополненной реальности был выбран 

кроссплатформенный инструмент для разработки компьютерных игр – Unity. 

Для создания приложения был использован один из самых популярных 

инструментов для создания приложений дополненной реальности – 

платформа Vuforia. Она хорошо совмещается со средой разработки Unity. 

Для разработки приложения дополненной реальности был установлен Unity 

версии 2018.2.10f1 Personal. AR-приложение решено разрабатывать для 

операционной системы (ОС) Android, которым обучающиеся смогут 

воспользоваться при помощи смартфонов как на уроке, так и дома. 

1.2 Анализ опыта использования дополненной реальности в процессе 

обучения школьников 

В последние 5-10 лет AR-технологии стали доступны широким массам. 

Большинство современных смартфонов, планшетов поддерживают 

возможность работы с приложениями AR. Это позволило расширить сферу 

применения данной технологии, направив ее в том числе и в 

образовательный процесс. 

В настоящее время многие учебные заведения применяют 

дополненную реальность при проведении лабораторных работ по физике и 

химии, практических занятий по астрономии, истории и другим областям 

наук. Принцип наглядности работает эффективнее, чем обучение по 
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учебникам, просмотр изображений, видео и прочее. Важно обучающемуся 

привить интерес к предмету, желание получать новые знания, углубляя уже 

полученные, именно этой цели отвечает технология дополненной 

реальности. Она дает возможность заинтересовать, раскрыть творческий 

потенциал, мотивировать к самостоятельным действиям и самообучению. 

Кроме того, применение преподавателем новых интерактивных методов 

обучения повышает его престиж среди обучающихся, т.к. они зачастую 

ассоциируют преподавателя с консерватором, которому чужды технические 

новинки [21].  

Стоит отметить, что использование дополненной реальности в 

обучении только набирает обороты, поэтому проведено малое количество 

исследований ученых в области использования AR в сфере образования. 

Среди ученых, занимающихся данной проблемой, выделим Х. Кауфманна, 

Л.Л. Лопез, Б. Мейера, Н. Ли, Л. Чанг и другие [36, 40, 39, 37]. Обоснование 

важности и описание особенностей применения технологий дополненной 

реальности в школе можно найти в работах A.A. Бельчусова, И.М. Клименко, 

А.В. Гриншкун, О.Н. Слободиной, Н. В. Софроновой [4, 19, 20] Считается, 

что дополненная реальность – более перспективное направление, чем 

виртуальная реальность (VR). AR-технологии при своей простоте позволяют 

сконцентрировать внимание обучающихся на самом важном, не отвлекая на 

второстепенные элементы виртуального мира. Огромным плюсом 

использования данной технологии является ее наглядность, информационная 

полнота и интерактивность, что позволяет развивать у обучающихся 

образное мышление и пространственное воображение. Также стоит отметить, 

что использование AR-технологий позволяет расширить возможности 

учебно-методических средств представления материала [6, 7, 9, 11]. 

Среди наиболее успешных реализованных идей использования AR-

технологии в обучении можно выделить несколько [26, 31, 35 и др.]: 



19 

 Визуализация простых и сложных алгебраических поверхностей – 

сфер, эллипсоидов, цилиндров, пирамид и др. Также визуализация 

особенно сложных – Бутылки Клейна, Ленты Мебиуса и пр. 

Необходимо не просто дать возможность увидеть такие объекты в 3D, 

но и возможность самостоятельно изменять параметры, визуализируя 

изменения, проводить сложные расчеты и наглядно демонстрировать, 

как это работает. 

 Визуализация физических уравнений. В математической физике 

дополненная реальность дает возможность показывать решение не 

просто в виде формулы, а в виде физического процесса. Изменяя 

параметры, можно влиять на результат, сразу оценивая его визуально. 

Также технология позволяет визуализировать сложные физические 

процессы – изотермический, изохорный, политропный и пр. 

 Визуализация строения молекул, отображение атомных орбиталей в 

химии. Человеческий глаз неспособен увидеть строение молекулы в 

реальности, только на снимках или штучно воссозданных моделях. 

Благодаря AR эта возможность появляется, что позволяет 

визуализировать даже сложные химические связи и лучше понять, как 

они формируются. 

Это небольшая часть возможностей и перспектив, которые дает 

использование в образовании технологий дополненной реальности. Можно 

быть уверенным, что в скором будущем будут появляться новые 

образовательные программы, AR-технология будет совершенствоваться и 

внедряться в большее число образовательных процессов. 

Потенциал использования дополненной реальности в сфере 

образования значителен. Использование мультимедийных виртуальных 

учебных объектов позволяет расширить возможности реализации 

эффективной познавательной деятельности и улучшить качество 

формируемых знаний и умений:  
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– Мультисенсорное восприятие: обучение с помощью AR позволяет 

обучающимся приобретать мультисенсорный опыт в процессе 

взаимодействия с виртуальным материалом (который включает в себя 

кинестетический опыт). 

– Разрушение границ: обучающимся зачастую трудно понимать 

абстрактные темы, физические и химические процессы, 

географические объекты в ограниченных условиях учебной аудитории 

или класса. С помощью AR появляется возможность путешествовать 

по недоступным местам, проводить опыты или эксперименты, 

визуально рассмотреть природные процессы. 

– Повышение вовлеченности обучающихся: для многих обучающихся 

вовлеченность в информатику является реальной 

психофизиологической проблемой (недостаток мотивации к обучению, 

отсутствие усидчивости, рассеянность внимания). Материал с 

дополненной реальностью позволит повысить интерес обучающихся за 

счет привлечения внимания и погружения в изучаемый материал, его 

наглядности. 

Приведем несколько примеров приложений дополненной реальности 

по трем направлениям: среднее и профессиональное образование, 

самообразование, начальное образование и обучение детей. 

Physics Playground – пособие по физике, которое позволяет 

моделировать физические эксперименты в дополненной реальности для 

обучения механике. Обучающиеся имеют возможность создавать 

собственные эксперименты и изучать их в виртуальном 3D-пространстве. В 

приложении предусмотрен разнообразный инструментарий для анализа сил, 

массы, траекторий и других объектов в течение экспериментов. 

Elements 4D – приложение для исследования химических элементов и 

их взаимодействия. Представляет собой набор из 6 кубиков с 

изображенными химическими элементами (36 элементов). При наведении 
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камеры смартфона на кубик на экране он становится стеклянным, а внутри 

появится изображение вещества. 

Star Walk (Sky Map AR) – интерактивная звездная карта неба, позволяет 

рассмотреть весь видимый космос (планеты, звезды и созвездия, спутники) в 

реальном времени. 

Pocket Tutor – AR-приложение, решающее несложные математические 

примеры прямо на бумаге. Нужно поднести смартфон к листу бумаги с 

решенным примером, и программа определит, правильное решение или нет, а 

также, в случае необходимости, покажет правильный ответ. 

AR Flashcards – Animal Alphabet – приложение направлено на малышей 

и пользователей, которые только начинают изучать английский язык. При 

наведении камеры на метку с буквой, на экране появляется животное, чье 

название начинается с данной буквы. Поддерживается закадровая озвучка. 

Arloon Plants позволяет изучить строение растений, узнать побольше 

об их жизненном цикле и основных особенностях. Приложение позволяет 

наблюдать за процессом, посадив и вырастив собственное 3D-растение, 

узнать о влиянии смены времен года и условий окружающей среды. 

Исходя из кратких описаний приложений, можно выделить некоторые 

дидактические возможности образовательных средств, в которых 

используются элементы дополненной реальности: текст сопровождается 3D-

моделями, аудио/видео; изображения превращаются в 3D-модели, которые 

можно изменять по желанию; технологии дополненной реальности 

позволяют воссоздавать физические, химические процессы. 

1.3 Анализ содержания обучения информатике в основной школе 

Как и у любой другой учебной дисциплины, цели и задачи изучения 

информатики связываются с формированием основ научного мировоззрения 

обучающихся, развитием их мышления, способностей, подготовкой к жизни, 

труду, продолжению образования. Информатика как учебный предмет 
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открывает обучающимся для систематического изучения одну из областей 

действительности – область информационных процессов. 

Основные содержательные линии курса информатики охватывают 

следующие группы вопросов: 

– вопросы, связанные с пониманием сущности информационных 

процессов, информационными основами процессов управления в 

системах различной природы (линия «Информационные процессы»); 

– способы представления информации (линия «Представление 

информации»); 

– методы и средства формализованного описания действий исполнителя, 

алгоритмы, основы программирования («Алгоритмическая линия»); 

– основы логики и системы счисления; 

– вопросы, связанные с выбором исполнителя для решения задачи, 

анализом его свойств, возможностей и эффективности его применения 

для решения данной задачи, архитектурой компьютера, функциями его 

основных устройств (линия «Компьютер»); 

– вопросы, связанные с методом формализации, моделированием 

реальных объектов и явлений для их исследования с помощью ЭВМ, 

проведение компьютерного эксперимента (линия «Формализация и 

моделирование»); 

– этапы решения задач на ЭВМ, использование программного 

обеспечения разного типа для решения задач, представление о 

современных информационных технологиях, основанных на 

использовании компьютера (линия «Информационные технологии»); 

– вопросы, охватывающие представления о передаче информации, 

канале передачи информации, телекоммуникациях, возможностях и 

услугах компьютерных сетей (линия «Телекоммуникации»). 

Классические учебные пособия и учебники не всегда в полной мере 

отвечают требованиям «цифровых учеников». На современном этапе 
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развития использование учебников с элементами дополненной реальности 

позволяет визуализировать изложенный учебный материал, что несомненно 

ведет к быстрому запоминанию, совмещать виртуальную реальность с 

физическим окружением, прикоснуться к миру 3D, а значит сделать процесс 

обучения более ярким, насыщенным и запоминающимся. Несмотря на то, что 

AR-технология действительно является актуальной и имеет ряд преимуществ 

перед традиционным обучением, в информатике мало элементов, которые 

могли бы быть представлены в виде 3D-объектов.  

Проведя анализ учебно-методических комплексов (УМК) по 

информатике нескольких авторов (И.Г. Семакина [17]; Л.Л. Босовой, А.Ю. 

Босовой [2]; К.Ю. Полякова, Е.А. Еремина [15]; Н.Д. Угриновича [22]), для 

разработки объектов дополненной реальности и использования этих объектов 

в процессе обучения выбрали тему «Алгоритмизация и программирование», 

в частности – алгоритмы сортировки. Для создания объектов дополненной 

реальности были выбраны несколько алгоритмов сортировки: 

 сортировка выбором (англ. Selection sort); 

 сортировка пузырьком (англ. Bubble sort); 

 сортировка слиянием (англ. Merge sort). 

Выбранная тема вызывает затруднения, связанные с пониманием, 

поскольку обучающимся сложно визуализировать объекты и закономерности 

процессов с ними. Использование технологии дополненной реальности 

позволяет повысить наглядность абстрактного теоретического материала и 

создает благоприятные условия для лучшего понимания и запоминания 

материала обучающимися, было решено показать сущность алгоритмов 

сортировки выбором, пузырьком и слиянием. Данные алгоритмы являются 

неотъемлемой частью раздела «Алгоритмизация и программирование», но в 

недостаточной мере наглядно представлены в школьных учебно-

методических материалах. 
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Таким образом, в результате анализа технологии дополненной 

реальности мы остановили свой выбор на маркерной технологии, для ее 

реализации нами была выбрана платформа дополненной реальности Vuforia 

SDK. Чтобы приступить к разработке приложения была определена тема 

«Алгоритмы сортировки» (сортировка выбором, пузырьком и слиянием) 

раздела «Алгоритмизация и программирование» курса информатики 

основной школы.  
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2 Разработка объектов дополненной реальности по школьной 

информатике 

2.1 Создание виртуальных объектов и маркеров (меток) 

Для создания приложения был использован один из самых популярных 

инструментов для создания приложений дополненной реальности – 

платформа Vuforia SDK. Она хорошо совмещается со средой разработки 

Unity. Интеграция Vuforia и Unity – мощный инструмент для создания AR-

приложений, которые могут быть легко установлены на смартфоны с 

операционными системами Android, iOS, Windows. 

Для начала прошли регистрацию на сайте «Vuforia engine» [42] для 

того, чтобы получить уникальный лицензионный ключ, который будет 

привязан к проекту. Также аккаунт необходим для того, чтобы хранить 

изображения-метки, к которым будут прикреплены виртуальные объекты. Во 

вкладке «Develop» нажали на кнопку «Get Development Key» для получения 

собственного лицензионного ключа (рис. 5). 

 

Рисунок 5. Получение лицензионного ключа 

Vuforia позволяет создавать несколько типов меток (рис. 6): 

– Single Image – отслеживание двумерного контрастного изображения; 

– Cuboid – отслеживание изображения на объекте кубической формы; 
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– Cylinder – отслеживание изображения на объекте цилиндрической 

формы; 

– 3D Object – отслеживание физического объекта. 

 

Рисунок 6. Создание метки в Vuforia 

Для нашего исследования в качестве метки использовались плоские 

изображения (Single Image), например: фотографии, картинки, логотипы и 

пр., так как их легче напечатать в учебных материалах к уроку и избежать 

технологических рисков. Изображение-метку можно создать с помощью 

любого удобного приложения для создания изображений. В нашем 

исследовании использовался графический редактор для создания растровых 

изображений – Paint (рис. 7), позволяющий создавать текст разных шрифтов, 

самостоятельно рисовать объекты и другое. 

При создании метки необходимо учитывать следующие аспекты: на 

качество исполнения влияют количество полигональных элементов, 

контрастность слоев и яркость определенных областей. Корректировка этих 

параметров позволяет готовить метки с высоким качеством для стабильной 

работы контента в сценах дополненной реальности. Также следует обращать 
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внимание на то, чтобы метка не была симметричной, что может вести за 

собой некорректное распознавание. 

 

Рисунок 7. Создание метки «Сортировка пузырьком» в Paint3D 

После создания необходимых меток, загрузили их в базу данных 

Vuforia, они будут использованы в дальнейшем как маркеры. Vuforia 

позволяет загружать метки в формате .jpg или .png, причем максимальный 

размер загружаемого файла не должен превышать 2 МБ. Ограничений к 

количеству загружаемых меток нет. Возможности Vuforia позволяют 

проанализировать изображение-маркер и показать симуляцию качества 

захвата мишени. Единицей шкалы инструмента является «звезда». 

Максимальное количество звезд – 5, а значит присвоенные метке 5 звезд – 

это максимально высокое качество проработки метки [12]. Количество звезд 

влияет на такие факторы, как качество и скорость захвата оптическим 

датчиком устройства, стабильность отображения контента, 

работоспособность при низком освещении. Если звезды желтого цвета, 

значит метка качественная и будет распознаваться без проблем (рис. 8).  

Нами была проведена коррекция разработанных меток в отношении 

симметричности метки, контрастности изображения и размера текста. В 
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конечном варианте нами были получены метки, имеющие 5 звезд, качество 

высокое, проблем с распознаванием возникнуть не должно.  

Полученную базу данных скачали для последующего импортирования 

в Unity в папку Assets. 

 

Рисунок 8. База данных на сайте Vuforia 

После всех подготовительных действий приступили к созданию 

проекта. Для этого в главном окне Unity создали новый проект. 

Без дополнительных настроек редактор Unity 3D работает в режиме 

виртуальной реальности, наше устройства должно работать одновременно в 

режиме камеры и плеера. Для этого открыли настройки плеера 

(Player Settings) и перевели работу в редактора в режим дополненной 

реальности вызовами: XR Settings → Vuforia Augmented Reality (рис. 9). 

 

Рисунок 9. Настройка режима работы редактора Unity 3D 
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В окне Hierarchy удалили стандартный объект Main Camera, так как она 

не позволяет выполнять визуализацию реального окружения, а работает 

только с виртуальными объектами сцены в виртуальном пространстве, и 

заменили его на AR-camera, используя следующие вызовы: Game Object → 

Vuforia → AR Camera. На следующем шаге начали процесс 

конфигурирования Vuforia для работы с Unity 3D. Привязали полученный 

ранее лицензионный ключ: вставили его в поле App License Key в области 

Inspector объекта AR-camera (рис. 10). 

 

Рисунок 10. Привязка лицензионного ключа 

Если выбрать на данном этапе поле Add License, то Unity 

автоматически отправит на этап генерации лицензионного ключа, что было 

сделано в первую очередь.  

На следующем шаге загрузили Базу данных меток. Выполнили 

настройки Unity 3D на загрузку базы данных Vuforia (Game Object → Vuforia 

→ Image), а затем из каталога в локальной файловой системе, где сохранена 

нужная база данных меток (файл с расширением .unitypackage), выбирали 

действие Edit Unity Package File. 

В результате в окне среды Unity 3D появилось диалоговое окно 

импорта базы данных меток (рис. 11). 
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Рисунок 11. Импорт базы данных меток Vuforia 

Для добавления меток, созданных нами ранее, на сцену (область, 

содержащую все объекты разрабатываемого приложения) добавили 3 объекта 

Image Target. Их можно найти во вкладке Game Object → Vuforia Engine → 

Image. Нужно было добиться правильного взаимного расположения камеры и 

метки, контролировать точность выполнения в окне Camera Preview в нижней 

правой части сцены. Хорошим результатом является тот, когда изображение 

Image Target занимает от 30% до 60% окна Camera Preview (рис. 12). 

 

Рисунок 12. Отображение взаимного расположения камеры и метки в окне 

Camera Preview 
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Далее добавили объекты, которые будут отображаться на 

определенных метках. Для этого связали Image Target с будущим объектом 

через объект Unity 3D: Image Target → 3D Object → Quad. Затем в контейнер 

Quad добавили компонент, содержащий и видеоплеер, и видеоклип: в 

инспекторе объекта Quad нажали кнопку Add Component. В появившемся 

списке компонентов выбрали Video → Video Player, затем с помощью drag-n-

drop (возможность захватить мышью элемент и перенести его) переместили 

видеоклип из поля Resource в поле Video Clip. 

Рисунок 13. Присвоенные меткам объекты на сцене 

Объекты размещены на сцене (рис. 13). Чтобы видео запускалось и 

повторялось после окончания, в Inspector’е объекта Quad в разделе 

Video Player установили флажок напротив Loop (рис. 14). 

 

Рисунок 14. Установка флажка для многократного повторения видео 

Запустив проект с помощью кнопки запуска, расположенной над 

сценой, убедились, что разработанные элементы дополненной реальности 
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работают корректно. После этого можно попробовать экспортировать 

получившийся проект для выбранной нами платформы Android.  

Для этого во вкладке File выбрали Build Settings. В появившемся окне в 

поле Platform выбрали ОС Android. В поле Scene in Build отметили 

сохраненную нами сцену (рис. 15). 

 

Рисунок 15. Настройки установки приложения для Android 

Также на компьютер потребуется установка Java DK и Android SDK, 

без которых приложение для устройства создать не получится. После 

установки, если все настроено корректно, при нажатии кнопки Build 

разработанный проект сгенерируется в apk-файл. Генерация apk-файла может 

вызвать появление ошибки. В нашем случае появилась ошибка, связанная с 

идентификатором пакета в настройках плеера. Мы сумели от нее избавиться, 

сопоставив в настройках Android значения полей Company Name (USPU) и 

Product Name (VKR_pr) со значением поля Package Name 

(com.USPU.VKR_pr), при этом значения Company Name и Product Name 

задавались самостоятельно в настройках плеера (рис. 16). 
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Рисунок 16. Название компании и разрабатываемого приложения в настройках 

плеера 

Сохраненный файл .apk разработанного AR-приложения следует 

загрузить на устройство Android любым известным способом. 

После установки приложения на устройство с ОС Android оно успешно 

запускается и работает без ошибок. При наведении камеры на созданные 

метки необходимые объекты отображаются (рис. 17, 18, 19). AR-объекты 

разработаны верно. 

 

Рисунок 17. Сортировка выбором как объект дополненной реальности на метке 
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Рисунок 18. Сортировка пузырьком как объект дополненной реальности на метке 

 

Рисунок 19. Сортировка слиянием как объект дополненной реальности на метке 

По желанию можно оформить логотип приложения, который будет 

отображаться уже у установленного приложения. 
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Краткие рекомендации по разработке и использованию виртуальных 

объектов 

При разработке элементов дополненной реальности для начала 

необходимо определиться с темами, которые будут реализованы в рамках 

данной технологии. Выбор темы и/или объекта должен быть обоснован 

невозможностью замены AR-технологии или сложностью визуализации 

объектов. Для того, чтобы создание элементов дополненной реальности было 

выполнено успешнее, целесообразно изучить уже имеющиеся разработки по 

выбранной научной области, в частности по выбранной теме. 

Следует определиться с выбором программного обеспечения, с 

помощью которого будут разрабатываться AR-элементы. Для этого нужно 

определить цель использования создаваемого объекта, например: если 

преподаватель планирует провести лабораторные работы, в ходе которых 

обучающиеся самостоятельно должны создать элементы дополненной 

реальности, то программное обеспечение должно быть с понятным 

интерфейсом, не иметь системных ошибок. 

Unity – платформа для разработки в реальном времени двух- и 

трёхмерных приложений и игр, работающая под операционными системами 

Windows, OS X, обладает визуальной средой разработки, межплатформенной 

поддержкой и модульной системой компонентов. 

Vuforia – платформа SDK для создания AR-приложений для 

смартфонов и планшетов на операционных системах iOS, Android, позволяет 

в реальном времени отслеживать плоские изображения и простые объемные 

объекты, распознает цилиндрические маркеры и текст. Платформа Vuforia 

SDK хорошо интегрируется с движком Unity.  

Краткое описание шагов разработки в Vuforia + Unity: 

1. Получение лицензионного ключа и создание базы данных меток 

(портал Vuforia Engine → License Manager → Get Development Key; портал 

Vuforia Engine → Target Manager → Add Database). 
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2. Привязка лицензионного ключа в Unity (AR Camera → Open Vuforia 

Configuration → App License Key). 

3. Добавление меток на сцену (Game Object → Vuforia → Image → Image 

Target → Image Target Behavior → Database). 

4. Правильное расположение камеры и метки (от 30% до 60% окна 

Camera Preview). 

5. Добавление отображаемых объектов на сцену (Image Target → 3D 

Object → Quad → Add Component→ Video). 

6. Сохранение сцены (File → Save scene). 

7. Создание приложения (File → Build Settings → Android → Build). 

a. При наличии ошибок компиляции – поиск путей решения. 

b. При отсутствии ошибок – пункт 8. 

8. Анализ работы приложения 

a. При наличии ошибок компиляции – поиск путей решения. 

b. При отсутствии ошибок – инсталляция на целевом устройстве. 

Для использования дополненной реальности в качестве 

вспомогательного средства обучения, преподавателю необходимо 

распечатать метки или загрузить их на каждый ПК в аудитории, дать 

обучающимся рекомендации по использованию разработанного AR-

приложения. 

Объекты, которые отображаются при наведении камеры на метку, 

должны быть доступны и понятны для каждого обучающегося. 

2.2Апробация разработанных ресурсов и анализ результатов 

Для апробации разработанных элементов дополненной реальности 

выделили две группы обучающихся – контрольную и экспериментальную. В 

качестве участников выступили обучающиеся 9-х классов МОУ «СОШ № 2» 

города Качканар Свердловской области (общее количество участников – 68 

человек). Все обучающиеся имели примерно одинаковый уровень 
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успеваемости. В экспериментальную и контрольную группы вошло по 34 

обучающихся. 

Перед началом обучения теме «Алгоритмы сортировки» было 

проведено входное тестирование, по результатам которого были установлены 

исходные знания обучающихся об алгоритмах сортировки. Входной тест 

включал в себя 6 вопросов, причем 3 из них были однобалльные, 2 вопроса – 

двубалльные, 1 вопрос, оценивающийся в 3 балла.  Максимальное 

количество баллов за тест – 10 баллов.  

Вопросы входного тестирования: 

1. Сортировка (упорядочение) массива – это … (1 б.) 

a. Удержание объекта в существующем состоянии; 

b. Перераспределение элементов массива в указанном порядке; 

c. Произвольное распределение элементов массива; 

d. Словесная информационная модель. 

2. Может ли массив содержать одновременно целые и вещественные 

значения? (1 б.) 

3. Цель сортировки массива: (1 б.) 

a. Перераспределить значения; 

b. Работать с базой данных; 

c. Облегчить последующий поиск элементов; 

d. Красиво расположить объекты. 

4. Как называют порядок, при котором в массиве первый элемент имеет 

самое маленькое значение, а значение каждого следующего элемента 

не меньше значения предыдущего значения? (2 б.) 

5. Порядок, при котором в массиве первый элемент имеет самое большое 

значение, а значение каждого следующего элемента не больше 

значения предыдущего элемента, называют … (2 б.) 

6. Дан массив MAS: 11, 35, 24, 7. Как будут располагаться его элементы в 

процессе сортировки по возрастанию после одного прохода? (3 б.) 
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a. 11, 35, 24, 7 

b. 11, 24, 35, 7 

c. 11, 24, 7, 35 

d. 7, 11, 24, 35 

После входного тестирования было проведено обучение контрольной и 

экспериментальной групп по теме «Алгоритмы сортировки» курса 

информатики основной школы в одинаковом объеме, но с использованием 

различных наглядных средств. Для обучения контрольной группы были 

выбраны традиционные средства визуализации учебного материала, 

экспериментальная группа обучалась с использованием средств технологии 

дополненной реальности. 

После обучения школьников было проведено итоговое тестирование с 

целью выявления целесообразности и эффективности использования 

технологии дополненной реальности как средства повышения качества 

обучения. Итоговый тест состоял из 10 вопросов, за каждый из которых 

обучающиеся могли получить по 1 баллу. Каждый участник тестирования 

мог получить от 0 до 10 баллов. Ниже приведены вопросы итогового 

тестирования: 

1. Каким обычно бывает порядок сортировки чисел? 

a. По количеству цифр в числе; 

b. По возрастанию/убыванию; 

c. По типу цифр. 

2. Поле, по которому происходит упорядочение данных, называется… 

a. Ключ поиска 

b. Ключ сортировки 

c. Порядок сортировки 

d. Структура данных 

3. Что означает стабильность алгоритма сортировки? 
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a. Процент ошибок при сортировке меньше 

b. При работе алгоритма относительный порядок пар с равными 

ключами не меняется 

c. Время работы алгоритма относительно стабильно при различной 

величине входных данных 

4. Как можно описать алгоритм сортировки методом пузырька? 

a. На каждой итерации последовательно сравниваются соседние 

элементы, и, если порядок в паре неверный, то элементы меняют 

местами. 

b. Для нового неупорядоченного элемента в правой части 

множества итеративно выбирается место среди уже 

упорядоченных ключей. 

c. Итеративно выбирается место среди оставшихся 

неупорядоченных ключей, найденный минимум или максимум 

вынимается из текущего множества в ответ. 

5. Временная сложность алгоритма сортировки методом пузырька равна: 

a. N 

b. N
2
 

c. N/2 

d. N ∙ lnN 

6. Производится пузырьковая сортировка массива из 6 элементов, причём 

массив упорядочен в обратном порядке. Сколько будет выполнено 

перестановок? 

a. 6 

b. 7 

c. 30 

d. 15 

e. 0 

7. Как можно описать алгоритм сортировки выбором? 
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a. Для нового неупорядоченного элемента в правой части 

множества итеративно выбирается место среди уже 

упорядоченных ключей. 

b. Итеративно выбирается место среди оставшихся 

неупорядоченных ключей, найденный минимум или максимум 

вынимается из текущего множества в ответ. 

c. Исходная последовательность А делится на две части А1 и А2, 

которые рекурсивно сортируются. 

8. Какое из следующих высказываний наилучшим образом характеризует 

сортировку отбором? 

a. Выполняет наименьшее число операций. 

b. Считается самой простой. 

c. Ищет наименьший или наибольший элемент. 

d. Не подходит для 1-мерных массивов. 

e. Считается самой быстрой. 

9. Для алгоритма сортировки слиянием при каком количестве элементов в 

последовательности рекурсивное деление должно прерываться, в 

стандартном виде? 

a. 2 

b. 1 

c. 3 

10. Как описывается алгоритм сортировки слиянием? 

a. Для нового неупорядоченного элемента в правой части 

множества итеративно выбирается место среди уже 

упорядоченных ключей. 

b. Итеративно выбирается место среди оставшихся 

неупорядоченных ключей, найденный минимум или максимум 

вынимается из текущего множества в ответ. 
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c. Исходная последовательность А делится на две части А1 и А2, 

которые рекурсивно сортируются. 

Для анализа полученных результатов был вычислен итоговый средний 

балл по входному и итоговому тестированию для контрольной группы (табл. 

2) для экспериментальной группы (табл. 3) в ходе проверки эффективности 

использования дополненной реальности в качестве средства обучения 

информатике. 

Таблица 2. Результаты входного и итогового тестирования контрольной группы 

Обучающийся Входное 

тестирование (баллы) 

Итоговое 

тестирование (баллы) 

Уч. 1 5 7 

Уч. 2 7 7 

Уч. 3 3 4 

Уч. 4 7 8 

Уч. 5 5 6 

Уч. 6 6 7 

Уч. 7 1 5 

Уч. 8 4 5 

Уч. 9 0 3 

Уч. 10 8 8 

Уч. 11 6 5 

Уч. 12 3 6 

Уч. 13 3 7 

Уч. 14 6 6 

Уч. 15 4 6 

Уч. 16 5 5 

Уч. 17 5 3 

Уч. 18 7 8 

Уч. 19 3 6 

Уч. 20 2 9 

Уч. 21 4 7 
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Уч. 22 5 7 

Уч. 23 2 6 

Уч. 24 1 5 

Уч. 25 0 4 

Уч. 26 7 8 

Уч. 27 3 6 

Уч. 28 5 5 

Уч. 29 5 4 

Уч. 30 3 8 

Уч. 31 7 7 

Уч. 32 3 6 

Уч. 33 2 4 

Уч. 34 4 8 

Средний балл 4,09091 6,0588 

 

Таблица 3. Результаты входного и итогового тестирования экспериментальной группы 

Обучающийся Входное 

тестирование (баллы) 

Итоговое 

тестирование (баллы) 

Уч. 1 4 8 

Уч. 2 5 7 

Уч. 3 5 7 

Уч. 4 8 6 

Уч. 5 3 9 

Уч. 6 4 10 

Уч. 7 7 8 

Уч. 8 1 7 

Уч. 9 6 6 

Уч. 10 2 8 

Уч. 11 1 6 

Уч. 12 0 8 

Уч. 13 0 6 

Уч. 14 3 7 

Уч. 15 5 9 
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Уч. 16 5 9 

Уч. 17 4 8 

Уч. 18 6 7 

Уч. 19 8 7 

Уч. 20 2 6 

Уч. 21 5 8 

Уч. 22 1 9 

Уч. 23 3 9 

Уч. 24 4 8 

Уч. 25 5 6 

Уч. 26 4 7 

Уч. 27 4 8 

Уч. 28 7 10 

Уч. 29 6 9 

Уч. 30 3 7 

Уч. 31 2 6 

Уч. 32 3 7 

Уч. 33 0 7 

Уч. 34 4 8 

Средний балл 3,8235 7,5882 

Как видно из таблиц 2 и 3, на входном тестировании контрольная и 

экспериментальная группы показали близкие результаты полученного 

среднего балла (4,09091 – для контрольной группы, 3,8235 – для 

экспериментальной группы). Результаты итогового тестирования 

показывают, что средние баллы различаются больше, что может 

свидетельствовать о том, что технология дополненной реальности, 

примененная в процессе обучения информатике, позволяет повысить 

доступность материала для восприятия и понимания и, соответственно, 

повысить качество образовательных результатов. Для визуального 

представления средних баллов была составлена гистограмма (рис. 20). 
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Рисунок 20. Гистограмма распределения средних баллов контрольной и 

экспериментальной групп 

Как видно из гистограммы, экспериментальная группа после обучения 

по теме «Алгоритмы сортировки» смогла получить более высокий средний 

балл, что может быть связано с применением технологии дополненной 

реальности как средства обучения. При этом разница оказалась 1,5294 балла 

в пользу экспериментальной группы по отношению к контрольной группе, 

которая обучалась с помощью традиционных средств обучения. Полученный 

результат позволил нам прийти к выводу, что применение технологии 

дополненной реальности может способствовать повышению эффективности 

обучения темам курса информатики, требующим большей наглядности. 

Отметим также, что в процессе работы с объектами дополненной 

реальности и приложением обучающиеся проявили большой интерес к теме 

«Алгоритмы сортировки», что было связано с включением смартфонов в 

образовательный процесс. Мы наблюдали, что школьники с увлечением 

работали с объектами, задавали вопросы, проявляли интерес не только к 

изучаемым алгоритмам, но и к технологии создания объектов дополненной 
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реальности, выразили желание изучать AR-технологию в рамках 

факультативных занятий. 
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Заключение 

Методически обоснованное использование элементов дополненной 

реальности в процессе обучения способствует повышению интереса к 

предмету и учебной мотивации, поскольку в ходе урока используются 

смартфоны или планшеты, активными пользователями которых являются 

современные обучающиеся; повышается наглядность учебного материала, 

что способствует лучшему запоминанию и пониманию содержания обучения; 

размещение виртуальных объектов в среде, в которой они изначально 

отсутствуют, позволяет смоделировать необычные образовательные 

практики. 

В ходе исследования проведен обзор педагогических практик 

использования и разработки объектов дополненной реальности в 

образовании, проанализированы комплекты средств разработки приложений 

с дополненной реальностью, выбрана среда разработки SDK Vuforia  на 

движке Unity. 

Для достижения целей исследования были разработаны объекты 

дополненной реальности, предназначенные для использования в процессе 

обучения информатике (алгоритмы сортировки выбором, слиянием и 

пузырьком). 

Разработано приложение для Android для отображения AR-объектов и 

сами объекты в виде анимаций, связанные с визуализацией алгоритмов 

сортировки (выбором, пузырьком, слиянием). Приложение и созданные 

объекты дополненной реальности прошли апробацию на уроках 

информатики в 9 классах. В работе сформулированы краткие рекомендации 

по разработке и использованию элементов дополненной реальности в 

обучении. Созданные AR-объекты могут быть использованы на уроках 

информатики в 9-х классах. Разработанные методические рекомендации 

могут служить основой для создания AR-объектов по содержанию других 

школьных дисциплин. 
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Цель исследования – разработка комплекса объектов дополненной 

реальности для использования в процессе обучения информатике в школе – 

достигнута. Все поставленные задачи решены.  
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